AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for Nuance OpenSpeech Attendant with
Avaya Voice Portal — Issue 1.0

Abstract

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Voice Portal and Avaya Communication Manager. Nuance
OpenSpeech Attendant allows callers to speak the name of a person, department, service, or
location and be automatically transferred to the requested party without waiting to speak to an
operator.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Voice Portal and Avaya Communication Manager. Nuance
OpenSpeech Attendant allows callers to speak the name of a person, department, service, or
location and be automatically transferred to the requested party without waiting to speak to an
operator.

Figure 1 illustrates the configuration used to verify the Nuance OpenSpeech Attendant (OSA)
solution with Avaya Voice Portal, Avaya Communication Manager, and the Nuance Speech
Server. Nuance OSA is deployed on a dedicated application server running Windows 2003
Server. Avaya Voice Portal interfaces to Avaya Communication Manager using a VolP H.323
interface. Avaya Voice Portal manages the interactions with speech server resources (i.e.,
speech recognition and text-to-speech) used by VXML applications. VXML pages generated by
Nuance OSA are loaded and interpreted by Avaya Voice Portal, which controls the interaction
with the user. To access the Nuance OSA application, a VolP channel on Avaya Voice Portal
must be configured to invoke the VXML application when an incoming call is received on that
channel.

=

Avaya S8700 Servers
(192.45.120.54)

Nuance OSA
Router (192.45.122.135)

Avaya G650 Media Gateway

CLAN: 192.45.120.75
( ) Nuance Speech Server

(192.45.122.134)

VPMS
(192.45.122.50)

Avaya 4600 Series
IP Telephones

MPP
(192.45.122.51)

Avaya Voice Portal

Figure 1: Configuration with Avaya Voice Portal and Nuance OpenSpeech Attendant
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1.1. Equipment and Software Validated
The following equipment and software were used for the sample configuration:

Equipment

Software

Avaya Voice Portal

4.1.0.1.2710
and Hotfixes wi00089856 and wi00075203

Avaya S8700 Servers with a G650 Media
Gateway

Avaya Communication Manager 4.0
(R014x.00.1.731.2)

Avaya 4600 Series IP Telephones

2.8 (H.323)

Nuance OpenSpeech Attendant (OSA)

3.0 with Hotfix 300HF04

Nuance Speech Server

= Nuance Recognizer 9.04
= Nuance RealSpeak 4.5
= Nuance MRCP Server 5.0.3
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2. Configure Avaya Communication Manager

This section describes the configuration of H.323 stations and the IP codec set for Avaya Voice
Portal. This configuration also requires a C-LAN and Media Processor board for IP
communication. This configuration is outside the scope of these application notes, but the reader
may refer to [1] and [2] for additional information. In addition, special application SA8874 —
Call Status Messages for 7434ND IP Softphone is required to support supervised transfers from
Avaya Voice Portal.

From the System Access Terminal (SAT), add an H.323 station for Avaya Voice Portal. A call
to this station will be routed to Avaya Voice Portal which will run the Nuance OSA. In the
station form, set the Type to 7434ND, provide a descriptive Name, set the Security Code, and
set the IP Softphone field to “y’.

add station 23802 Page 1 of 6
STATION
Extension: 23802 Lock Messages? n BCC: O
Type: 7434ND Security Code: XXXXX TNz 1
Port: S00059 Coverage Path 1: COR: 1
Name: VP 192.45.122.50 Coverage Path 2: CoS: 1

Hunt-to Station:
STATION OPTIONS
Time of Day Lock Table:

Loss Group: 2 Personalized Ringing Pattern: 1
Data Module? n Message Lamp Ext: 23802
Display Module? y
Display Language: english Coverage Module? n
Survivable COR: internal Media Complex Ext:
Survivable Trunk Dest? y IP SoftPhone? y

IP Video Softphone? n

Figure 2: Station Form

In the IP codec set form associated with the IP network region of the H.323 station, configured in
Figure 2, set the Audio Codec field to the appropriate value. In this configuration, G.711MU
was used.

change ip-codec-set 1 Page 1 of 2
IP Codec Set

Codec Set: 1

Audio Silence Frames Packet

Codec Suppression Per Pkt Size(ms)
1: G.711MU n 2 20
2:
3:
4:

Figure 3: IP Codec Set Form
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3. Configure Avaya Voice Portal

This section covers the administration of Avaya Voice Portal. The following Voice Portal
configuration steps will be covered:

= Configuring an H.323 VolIP connection

= Adding an MPP server

= Configuring the VolP audio format (mu-law or a-law)
= Adding a speech server

= Adding applications

= Starting the MPP server

Avaya Voice Portal is configured via the VVoice Portal Management System (VPMS) web
interface. To access the web interface, enter http://<ip-addr>/VoicePortal as the URL in an
internet browser, where <ip-addr> is the IP address of the VPMS. Log in using the
Administrator user role. The screen shown in Figure 4 is displayed.

Note: All of the screens in this section are shown after the Avaya Voice Portal had been
configured. Save the screen parameters during configuration of Avaya Voice Portal.

Welcome, admin
Last logged in yesterday at 5:58:33 PM EDT

AVAYA

Voice Portal 4.1 (VoicePortal) # Home ?-Help @ Logoff

Expand &ll | Collapse &l

¥ User Management
Users Voice Portal Management System version 4.1.0.1.2710
¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewer
Log Viewer
Alarm Manager

Voice Portal Management System (VPMS) is the consolidated web-based application for administering
Voice Portal. Through the WPMS interface, vou can configure Voice Portal, check the status of a Voice
Partal component, and generate reports related to system operation.

Legal Notice

¥ System Configuration © 2005 — 2007 Avaya Inc. All Rights Reserved. ]|
Applications =
Certificates Hotios
Licensin i . B B
mpp Ser?,em While reasonable efforts were made to ensure that the information in
Report Data this document was complete and accurate at the time of printing,
SNMP Avaya Inc. can assume no liability for any errors. Changes and

Speech Servers
Viewer Settings
VoIP Connections
VPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail
Performance
Session Summary
Session Detail

corrections to the information in this document might be
incorporated in future releases.

Documentation disclaimer

Avaya Inc. i=s not responsible for any modification=s, additions, or
deletions to the original published wersion of this documentation
unless such mpdifications, additions, or deletions were performed by
Avaya. Customer and/or End User agree to indemnifyv and hold harmless
Avaya, Avaya's agents, servants and employees against all claims,

Last Login: 6/16/08 5:58:33 PM EDT

Figure 4: VPMS Main Screen
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Configure the H.323 VolP Connection. To configure an H.323 connection, navigate to the
VolP Connections page and then click on the H.323 tab. In the H.323 tab shown in Figure 5,
set the Gatekeeper Address to the IP address of the C-LAN in the G650 media gateway and the
Gatekeeper Port to 1719. Next, configure the stations for Avaya Voice Portal, which map to
the 7434ND stations configured in Avaya Communication Manager. In addition, set the
Password for the stations and set the Station Type to Inbound and Outbound. In this
configuration, stations 23801 to 23808 are assigned to Avaya Voice Portal, but only stations
23802 and 23803 are mapped to the Nuance OSA on Avaya Voice Portal.

AVA A Welcome, admin
Last logged in yesterday at 5:58:33 PM EDT

Voice Portal 4.1 (VoicePortal) % Home ?.Help @ Logoff

Expand All | Collapse All
erae: Home > Syste tio VolIP Connections

¥ User Management . ) B "
Users Change H.323 Connection

¥ System Maintenance
System Monitor

Use this page to change the configuration of an H.323 connection.
MPP Manager

Active Calls

Port Distribution Mame: CRMSRW

Audit Log Viewer :

Log Viewer Enable: @ Yes © no
By MdTeaics Gatekeeper Address: 192.45.120.75

¥ System Configuration
Applications
Certificates
Licensing Gatekeeper Port: 1719
MPP Servers
Report Data Media Encryption: O ¥es @& No
SNMP
Speech Servers
Viewer Settings New Stations
VolP Connections
VPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail Password:
Parformance

Session Summary Same Password
Session Detail

Alternative Gatekeeper Address:

Fram To

Station:

Use sequential passwords

[Inbound and Outbound
Station Type: | Inbound Only Add |
._Maintenance

Configured Stations (M for Maintenance, I for Inbound Only)

23801 - 23808

Remove J

[Sove ooty cancel J e

Figure 5: H.323 Connection

JAO; Reviewed: Solution & Interoperability Test Lab Application Notes 6 of 28
SPOC 7/28/2008 ©2008 Avaya Inc. All Rights Reserved. Nuance-OSA-VP



Add an MPP Server. Add the MPP server by navigating to the MPP Servers screen by
selecting the option from the left pane. In the MPP Server configuration page, specify a
descriptive Name and the Host Address of each MPP server. Also, specify the Maximum
Simultaneous Calls supported by each MPP server. Figure 6 shows the configuration for the
first MPP server.

Welcome, admin
Last logged in yesterday at 5:58:23 PM EDT

AVAYA

Voice Portal 4.1 (VoicePortal)

Expand All | Collapse All
=re: Home = Syste C MPP Servers > Change

¥ User Management - ) -
Users Change MPP Server

¥ System Maintenance
System Monitor

MPP Manager
Active Calls

Part Distribution
Audit Log Viewsr

Use this page to change the configuration of an MPP. Take care when chanaing the MPP Trace
Logging Thresholds. Do not set Trace Levels to Finest if your Voice Portal system has heawvy call
traffic. The system might experience performance issues if Trace Levels are set to Finest. Set
Trace Levels to Finest only when you are troubleshooting the system.

Log Viewsar
Alarm Manager
* System Configuration

Name: mppl
Host Address: 192.45,122.51

Applications

Certificates Network Address (VoIP): <Default=
Licensing

MPPE Servers Network Address (MRCP): <Default=
Report Data

SNMP Maximum Simultaneous Calls: |8

Speech Servers

Viewer Settings Restart Automatically: O yes @& No

VoIP Connections
VPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail
Performance
Session Summary
Session Detail

MPP Certificate

Owner: CH=mppl, C=Aveya, OU=MPPE
Issuer: CN=mppl,C=Avaysz, OU=MPP
Serial Mumber: 9c&lllelckf7073c
Valid from: Mon May 12 21-4%5:01 EDT 2008 until:- Thu May 10 21-45:01 EDT 2018
Certificate fingerprints
MDS: 57:0£f:a7:2l:8c:lezeb:ld:3a:-41:4B:6b:56:a5:5£:d1
SHA: 0B8:db:5a:7b:3c:4e:02:43:fc-0a:92:31:-:83:-ed-a%:05:-0e:1b:232:£f3

Categories and Trace Levels »

 save [ Avoly i cancel J§ Help |

Figure 6: MPP Server
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Configure the VoIP Audio Format. The VolP Audio Format for the MPP server is
configured in the VolP Settings screen accessible by selecting MPP Servers in the left pane.

The MPP Native Format field in Figure 7 is set to audio/basic for mu-law.

AVAYA

Voice Portal 4.1 (VoicePortal)
Expand All | Collapse all

¥ User Management
Users

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewer
Log Viewer
Alarm Manager

¥ System Configuration
Applications
Certificates
Licensing
MPP Sarvers
Report Data
SNMP
Speech Servers
Viewer Settings
VoIP Connections
WPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail
Performance
Session Summary
Session Detail

Last logged in yesterday at 5:58:322 PM EDT

r=: Home Systam Co gura i MPPE Servers

VolIP Settings

Voice over Internet Protocol (WVoIF) is the process of sending voice data through a network
using one or more standard protocols such as H.323 and Real-time Transfer Protocol (RTP).
Use this page to configure parameters that affect how woice data is transferred through the
network. Note that if vou make any changes to this page, you must restart all MPPs.

Port Ranges

Low [___High |
UDP: 30000 30999
TCP: 31000 31599
MRCP: 32000 32999

RTCP Monitor Settings
Host Address:

Port:

VoIP Audio Formats

MPP Mative Format: | audio/basic Vl:
QoS Parameters

[ vian ] Diffserv |
H.323: 6 46
SIP: 6 46
RTSP: 6 46

Out of Service Threshold (% of VoIP Resources)

Trigger | _ Reset |

Warn: 10 0
Error: 20 10
Fatal: 70 50

| save Jf Avoly i cancel ff Help |

Welcome, admin
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Add an ASR Server. To configure the automatic speech recognition (ASR) server, click on
Speech Servers in the left pane, select the ASR tab, and then click Add. Figure 8 shows the
screen after the ASR server has already been configured. For a Nuance Speech Server, the
Engine Type should be set to Nuance. Set the Network Address field to the IP address of the
Nuance Speech Server and select the desired Languages supported by the applications. The
Total Number of Licensed ASR Resources should also be set to the appropriate value. The

other fields were left at their default values.

AVAYA

Voice Portal 4.1 (VoicePortal)

Expand All | Collapse All

¥ User Management
Users

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewer
Liog Wiewer
Alarm Manager

¥ System Configuration

Home

Change ASR Server

U=e this page to change the configuration of an ASR server.

MName:

Enable:

Engine Type:

Welcome, admin
Last logged in yesterday at 5:58:32 PM EDT

Speech Servers = Chs

Nuance ASR
& ves O No

Applications Metwork Address: 192.45.122.134

Certificates

Licensing Base Port: 4900

:Zgu?teg:tr: Total Number of Licensed ASR Resources: 4

SNMP :

MRCP P Int I 15

Speech Servers skttt =coond(=)

Wiewer Settings MRCF Response Timeout: 4 second(s)

VolIP Connections

WVPMS Servers Mew Connection per Session: ) ves ) Mo

¥ Reports

Application Summary RTSP URL: 192.45.122.134/media/speechrecognize

Application Detail = -

Call Summary |Butch(Metherlands) nl-nl Il

Call Detail |English{Australia) en-au '

pstotenins |English(GreatBritain) en-gb

Session Summary Languages: | ; i :

Session Detail Engl!shl[ln_dla] en-in
|[English{Singapore) en-5G |
|English{USA) en-us |

[ Save Jf svoly | el |
Figure 8: ASR Speech Server
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Add a TTS Server. To configure the TTS server, click on Speech Servers in the left pane,
select the TTS tab, and then click Add. Figure 9 shows the screen after the TTS server has
already been configured. For a Nuance Speech Server, the Engine Type should be set to
Nuance. Set the Network Address field to the IP address of the Nuance Speech Server and
select the desired Voices supported by the applications. The Total Number of Licensed TTS
Resources should also be set to the appropriate value. The other fields were left at their default

values.

AVAYA

Voice Portal 4.1 (VoicePortal)
Expand All | Collapse All

¥ User Management
Users

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewer
Log Wiewer
Alarm Manager

¥ System Configuration
Applications
Certificates
Licensing
MPPE Servers
Report Data
SNMP
Speech Servers
Viewsr Settings
VolIP Connections
VPMS Servers

¥ Reports
Application Summary

Welcome, admin
Last logged in yesterday at 5:58:32 PM EDT

Home Speech Servers -

Change TTS Server

Use this page to change the configuration of a TTS server.

MName: Muance TTS
Enable: @& ves O Mo
Engine Type:

Metwork Address: 192.45.122.134

Base Port: 4900

Total Mumber of Licensed TTS 4

Resources:

MRCF Ping Interval: 15 second(s)
MRCF Responsze Timeout: 4 second(s)
New Connection per Session: ) ves (& Mo

Application Datail RTSP URL: :I..E2.45.122.134fmediaf5peech5vnthesiz i
g:: S [English(South African) af-ZA TessaF  |»
e T English(Scottish) en-SC Fiona F
Session Summary i EﬂghEhl:US} en-US Donna F
Session Detail English(US}) en-US Erica F
English(US) en-US Jennifer F [
|Engishtio) co-tis ML Lae]]
 eip|
Figure 9: TTS Server
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Add an Application. On the Applications page, add an Avaya Voice Portal application.
Specify a Name for the application, set the MIME Type field to the appropriate value (e.g.,
VoiceXML), and set the VoiceXML URL field to point to the Nuance OSA application. Next,
specify the type of ASR and TTS servers to be used by the application and the called number that
invokes the Nuance OSA application. The Applications screen is shown in Figure 10.

Welcome, admin
Last logged in today at 10:06:08 PM EDT

AVAYA

Voice Portal 4.1 (VoicePortal)

Expand All | Collapse All i . R

¥ User Management
Users Change Application

¥ System Maintenance
System Monitor Use this page to change the configuration of a WoiceXML or CCXML application.

MPP Manager

Active Calls

Port Distribution

Audit Log Viewer

Log Viewer

Mame: Nuance OS5A
Enable: (&) ves () No

Alarm Manager MIME T '_ m—”vf
¥ System Configuration ypei| VDIC_EXML ———— | ||
Applications VoiceXML ; :
il URL: http://192.45.122.135:8080/0penSpeech/Attendant/serviet/aa I Verify |
Licensing
MPP Servers
Report Data Speech Servers
SHNMP ' Tl & T =]
SReath Servers ASR: ._Nuance._.__v__._-_. TTS: _:Nuance v
E‘;ﬁéf:nﬂ;:g; = [English(USA) en-us [English{US) en-US Jennifer F
VPMS Servers Languages: | Voices: I English(US) en-US Jill F

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail
Performance
Session Summary
Session Detail

Application Launch

Type: (& Inbound ) Inbound Default ) Outbound

& Number ) Number Range O url
Called Number:

| Add |
23802

23803 Remove |

Speech Parameters »
Reporting Parameters »
Advanced Parameters »

 Save [ Avoly [ Cancel | elp |

Figure 10: Applications
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Start the MPP Server. Start the MPP server from the MPP Manager page shown in Figure 11.
Select each MPP and then click the Start button. After the MPP is started, the Mode of the MPP
should be Online and the State should be Running.

AVAYA

Voice Portal 4.1 (VoicePortal)
Expand All | Collapse All

¥ User Management
Usears

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Paort Distribution
Audit Log Viewsr
Log Viewer
Alarm Manager

¥ System Configuration
Applications
Certificates
Licensing
MPP Servers
Report Data
SHMP
Speach Servers
Viewer Settings
VoIP Connections
VPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Datail
Performance
Session Summary
Session Detail

Welcome, admin
Last logged in yesterday at 5:58:22 PM EDT

sre here: Home > System Maintenance = MPP Manager
MPP Manager (6/17/08 8:33:54 PM EDT) Resh

This page displays the current state of each MPF in the Voice Portal system. To enable the
state and mode commands, select one or more MPPs. To enable the mode commands, the
selected MPPs must also be stopped.

Last Poll: 6/17/08 8:33:53 PM EDT

- = T Auto |Restart Schedule |Active Calls
rver Name e Restart| Today Recurring| In

[¥] mpp1 Online Stopped Need ports No & No & None & 0

State Commands Restart/Reboot Options

(' One server at a time

| reboot |

% All selected servers

at the same time
Mode Commands

Figure 11: MPP Manager
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4. Configure Nuance OpenSpeech Attendant

This section covers the procedure for configuring Nuance OpenSpeech Attendant (OSA). The
procedure includes the following areas:

= Administer settings in the Configuration Panel
= Administer transfer entries in the Phone Directory and Menu Editor
= Administer top-level menu in the Phone Directory and Menu Editor

Nuance OSA is configured through Admin Tools which can be started by navigating to
Start->Nuance->Admin Tools. The initial screen is displayed as shown in Figure 12.

Wi Admin Tools [_ O]

Op-wSpeech'

ATTENDANT

Start
Stop

b onitor

Prompt R ecaorder

Phone Directary and kenw Editor

Report Generator

— LI = N =
Load Mew Configuration

Backup / Restore

D ata import

Call Analyzer
Help

Figure 12: Admin Tools
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4.1. Administer Settings in the Configuration Panel

To open the Configuration Panel, click on this option in the Admin Tools window in Figure
12. The login prompt will be displayed to the user as shown in Figure 13. Log in with the
appropriate credentials using Level 2 access level.

Configuration password |

Aocess level

ILE'-.-'E| 2 j

Paszwiord

Ixxxxm1

Ok, Cancel

Figure 13: Configuration Panel Login Window

The Configuration Panel show in Figure 14 is displayed. The Configuration Panel allows the
transfer mode and operator extension number to be configured. Nuance OSA supports blind,
supervised, and bridged transfers with Avaya Voice Portal. To enable OSA for blind transfers,
set the Gateway Transfer Mode Supervised and Gateway Transfer Mode Bridged fields to
NO as shown in the figure below. For supervised and bridged transfers set the corresponding
fields to YES. The Operator Extension Number field should be set to a valid extension on
Avaya Communication Manager. Click Apply.

&l Configuration panel - level 2 Hi=] E3
File Tools Help
Setting | | Current value | Default ﬂ Operator Extension Number |
Mumber of Ports 3> 6 1
External Voice Mail Prefix & 4001, &.4001... I??gﬂz
External Yoice Mail Suffix # #
Dialing Prefises for External Numbers 9 3
Mumber of Digits in Area Codes 3 3
Mumber of Digitz in Extemal Phone Numbers T T
Default Transfer Optiote SUPERYISED SUPERYISED
@ Gateway Transfer Mode Supervised <+ NO FROM ENTRY
@ Gateway Transfer Mode Bridged MO MO
Gateway Transfer Connection Timeout i} 3
Gateway Transfer bMasimum Call Duration 36000 36000
Gateway Transfer Options Sting
Gateway Transfer Pausze Character p p
Gateway Transfer URI type TEL TEL
Gateway Transfer SIP URI suffis localhost: 5060 localhost: B0E0
Transfer Connect Service Prefix 8 8
Call Analyzer recorded channels o ALl MOME
System Languages en-US en-US
@ Dperator Extension Mumber 7302 0
TDD Operator Extension Mumber i} 0
Speed-Dial Key 1 ] ]
Speed-Dial Key 2 i | 3
Speed-Dial Key 3 33 33 = Bestore |
| | ;lJ
Licenze
Figure 14: Configuration Panel
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Note: To support supervised transfers, the special application SA8874 — Call Status Messages
for 7434ND IP Softphone must be enabled on Avaya Communication. When using supervised

transfers, the caller won’t hear any ringing during the transfer attempt.

Next, close the Configuration Panel. Activate the changes when prompted by the system as

shown Figure 15.

e N |

] You have made changes that require a swskem restart.
[ Do o wank to dao it nows

Figure 15: Activate Changes in Configuration Panel
The following window is displayed. Click OK.

Starting OpenSpeech Attendant

Qpenapesch Attendant skarkup in progress

Figure 16: Startup in Progress Window
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4.2. Administer Transfer Entries in Phone Directory and Menu Editor
From Admin Tools, click on the Phone Directory and Menu Editor option. Figure 17 is

displayed.
i Menu Editor =]
File Edit “iew Tools Help
BB B @ EGY  Gw 0 m TR ® e
enus Content of "'Toplewvel Menuh”
=-{E] Toplevel Mernu | 5L Mame | Department | Locati.. | SR [ Mumber | Phan.. [ D[ 4. |
E-I' Cellular Phones s
: Croft, Lara X Fra02 Office =
: F.ent, Clark X 2m Office =
: Marketing X Fra02 Office =
: Petrino, Fobert X G464 Office = kS
£ Sales X 03 Office X
: Smith, John M arketing X Fra03 Office =
: Smith, John Sales ® g Office =
1 entries selected |
Phone Directary | Drata import |
Figure 17: Phone Directory and Menu Editor
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Next, select File>New->Transfer Entry from the menu options. The Creating transfer entry
window is displayed as shown in Figure 18. Configure the First names and Last names for this
entry and set the Phone number to a valid extension. Enable the Access to personal functions
and Access to name recorder options and set the PIN field so that this user can access the
Personal Administration Mode (PAM) to change their name recording. Click OK.

E‘f Creating transfer entry
Marme in directary I [~ Deactivated entiy
MHames i i
|Advanced| Eall.t’-‘«ccountlng' Infolmatmnl S chedule Ip’-‘n.lways j
First names Middle names Last names Alwaps |
Dravid Wellz »
— — — ¥ Speech recogrition
Mumber type Mumber 5 U FM# Priv
[ |Office > ||77305 FrrFr
r [~ | == 1
Aliazes [Englizh [115])
Voice file status | Language | Allowr
@ Missing English [US) [V Access to personal functions
[# Yoice biometi MessagelNDne i Mew
Cusztomn Prompt
[~ Mever propose this name I““’"‘
Previous MNew st | 0k Carcel Apply
Figure 18: Creating Transfer Entry
17 of 28
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The new transfer entry is now displayed in the Menu Editor window, but the entry has not been
activated yet. Highlight the new transfer entry and then click on the Activate Changes icon

[=],

il Menu Editor H=] E3
File Edit Wiew Tools Help
b B e @ -G Gy o, E T Em e
Menus Content of "Toplewel Menuh"
-{E] Toplevel Menu | 71 Mame | Department | Locati.. | SR [ Mumber | Phan.. [ D.. [ A |
E Cellular Phones .‘><
Craft, Lara ® Fra02  Office x
t Kent, Clark ® 2m Office =
t Marketing " a2 Office w8
t Fetring, Robert ® BaG64 Office = x
t Sales *® 7703 Office ®
t Srnith, John b arketing .‘>< Fra03 Office =
t Srnith, John Sales .‘>< a4 Office =
t wiells, David * Office ®

1 entries selected

Phione Directary |

Data import |

Figure 19: Menu Editor with New Transfer Entry

The following prompt is displayed to activate the new transfer entry so that it would be

recognized by Nuance OSA.

Change Activation

&n activation of the changes has been requested,

Figure 20: Change Activation
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4.3. Administer Top-Level Menu in Phone Directory and Menu Editor

Nuance OSA allows the configuration of multiple entry points. The use of multiple entry points
enable individual services or departments to be assigned a different entry point, which can be
configured using a DNIS or CLID number. When a call is received, Nuance OSA can route the
call to the appropriate entry point based on the dialed number (DNIS) or the caller’s phone
number (CLID). In this example, an entry point was configured using the DNIS option.

Create a new entry point by selecting File->New->Top-Level Menu from the menu options. The
window in Figure 21 is displayed. Enter a descriptive name in the Aliases field, enable the
Access to name recorder option, and set the PIN field for use with PAM. Click OK and
activate the changes.

E‘f Creating Menu
MHarme in directony I [~ Deactivated entry
Hames |Advanced| Call decounting | Information | Menu Behaviar | Secuity Access |
Schedule I.t’-‘n.lways j
First names Middle hames Last names

Accers code ||

v Call redirect pemitted

Drefault number

I.t‘-\ny type j
Conversation template
IDefauIt j_l
Aliazes [English [US]) Always |
DMIS Test

Settings |Greeting| F'r-:mpt' Bltemative F'r-:mptl Help A I *

v Speech recognition

IMenu behavior 1 j Mew |

Mumber of utterances Operator extension

Voice file status | Language | Al IDefauIt j I
@ Missing English (5] [~ Access to personal functions Mumber of zpellingz YWaoice profile
™ Woice biometrics IDefauIt j IDefauIt fram entry ijJ
V' Access to name recorder Mumber of interactions Barge-in function
Al IDefauIt j IDefauIt from enty poj
M thi I“’"‘”—
M [zt oot i s [~ Alwaws ask for confirmation
[ Listing of entries
Frexvious 2 [ 2t | K Cancel Apply
Figure 21: Creating Menu
JAO; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 28

SPOC 7/28/2008 ©2008 Avaya Inc. All Rights Reserved. Nuance-OSA-VP



From the Menu Editor, navigate to Edit-=>Ports and Entry Points to display the window in
Figure 22. Select the first item under Port assignment in the left pane and then select
Add->Entry Point from the menu options. Figure 23 is displayed.

E{ Ports and Entry Points B

Edit add Wiew

—Port aszignment I —Port group
=4 OCROOM:
Drefault Menu.Entry Pairit 1 Paits | DNIS/CLID Summaryl
P Mew entry point
i Unassigned
v v v v
POCROOM:1 POCROOM:2 POCROOM:23 POCROOM:4
v
POCROOM:&
[~ Show anly the entry poinks of I all j
Delete G Mew G
[~ Show anly the part groups of ] j ey St HekR |
Caomputer Management... | 0k | Cancel |
| |
Figure 22: Ports and Entry Points
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In the Ports and Entry Points window in Figure 23, set the Home menu and Main menu to the
new entry point configured in Figure 21. Select the DNIS/CLID tab and enter an extension
associated with an Avaya Voice Portal station configured on Avaya Communication Manager as
shown in Figure 2. Click OK. In this example, this entry point will be used when Nuance OSA
receives a DNIS of 23803.

E{ Ports and Entry Points E3

Edit Add  Wiew

—Port assignment I —Entry paint
El- Ports : POCROOM:1.2,3.4.5 - -
Default tMenu Entry Paint 1 Diescription INEW entry poin
MHew entry paint Harme meru IDNIS Test j_l
i Mew entry point _
Unassigned b ain menu IDNIS Test j_l
[~ Transfer Connect
WUl Settings  DNIS/CLID |
DNIS II:LID
23803
[~ Show anly the entry paints of I All j
I~ Show only the part groups of ] j
Remowe from Paort Group Delete | Mew |
Caomputer Managemernt... | ] | Cancel |
[Modified |

Figure 23: New Entry Point (DNIS/CLID Tab)
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In the VUI Settings tab, set the Voice Profile as shown below. Click OK.

E{ Ports and Entry Points E3

Edit Add  Wiew

—Port assignment I —Entry paint
El- Ports : POCROOM:1.2,3.4.5 L g
- Default Menu Entry Paint 1 Description INEW entry point
- Mew entry paint Home menu IDNIS Test j_l
-~ Mew entry paint _
Unassigned b ain menu IDNIS Test j_l

[~ Transfer Connect

WUl Settings | oIS ACLID |

Yaoice profile standard, female

[~ Express mode

" Barge-in off {* DTHMF is global
" Barge-n on after first greeting € DTMF is local ta EF
" Barge-in an after first prompt [ Allow DTMF pass through

% Bargein always Dperatar O peratar
on duty off duty

Mumber of utterances 2 | -

Humber of zpelings 0 |E 2 |

I Shaw only the entry paints of I Al j Humber of interactions L1 0 -

I~ Show only the part groups of ] j IR Vsl I j
Remowe from Paort Group | Delete | Mew |
Caomputer Managemernt... | ] | Cancel |
[Modified |

Figure 24: Ports and Entry Points (VUI Settings Tab)
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5. Interoperability Compliance Testing

This section describes the interoperability compliance testing used to verify the Nuance
OpenSpeech Attendant with Avaya Voice Portal. This section covers the general test approach
and the test results.

5.1. General Test Approach

The interoperability compliance test included feature and serviceability testing. Feature testing
focused on that Nuance OSA can successfully recognize spoken names and extensions entered
via DTMF and transfer the call to the correct destination. Blind, supervised, and bridged
transfers were verified.

Serviceability testing focused on verifying the ability of the Nuance OSA to recover from
adverse conditions, such as server restarts, power failures, and disconnecting cables to the IP
network.

5.2. Test Results
All test cases passed.
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6. Verification Steps

This section provides the verification steps that may be performed to verify that Avaya Voice
Portal can run the Nuance OSA.

1. From the VPMS web interface, verify that the MPP servers are online and running in the
MPP Manager page shown in Figure 25.

AVAYA

Voice Portal 4.1 (VoicePortal)
Expand All | Collapse All

¥ User Management
Users

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewsr
Log Viewer
Alarm Manager

* System Configuration
Applications
Certificates
Licensing
MPP Servers
Report Data
SHNMP
Speech Servers
Viewer Settings
VolP Connections
VPMS Servers

¥ Reports
Application Summary
Application Detail
Call Summary
Call Detail
Performance
Session Summary
Session Detail

Welcome, admin
Last logged in yesterday at 5:58:22 PM EDT

You are here: Home > System Maintenance PP Manzage

MPP Manager (6/17/08 8:37:55 PM EDT) Bafredh

Thiz page displays the current state of each MPP in the Voice Portal system. To enable the
state and mode commands, select one or more MPPs. To enable the mode commands, the
szelected MPPs must also be stopped.

Last Poll: 6/17/08 8:37:52 PM EDT
S A Autl:l Restart Schedule | Active Calls
e R estart| Today Recurring In Cut
mppl Online Running OK Mo & Mo &  None & o

State Commands Restart/Reboot Options

Mode Commands

[t |

Figure 25: MPP Manager
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2. From the VPMS web interface, verify that the ports on the MPP server are in-service in

the Port Distribution page shown in Figure 26.

AVAYA

Voice Portal 4.1 (VoicePortal)
Expand All | Collapse All

¥ User Management
Users

¥ System Maintenance
System Monitor
MPP Manager
Active Calls
Port Distribution
Audit Log Viewsr
Log Viewer
Alarm Manager

¥ System Configuration

=re: Home > Syste

Port Distribution (6/17/08 8:38:38 PM EDT) 2]

This page displays information about how the telephony resources have been distributed to
the MPPs. You configure the telephony resources on the WolP Connections page.

Total Ports: 8

mmw Port Group Current Allocation |Base Allocation

Welcome, admin
Last logged in yesterday at 5:58:23 PM EDT

Last Poll: 6/17/08 8:38:38 PM EDT

e 23801 Online In service CRMSRV H323 mppl
Applications : :
Coartificba 23802 Online In service CRMSRV H323 mppl
Licensing 23803 Online In service CRMSRV H323 mppl
MER Servers 23804 Online In service CRMSRV H323 mppl
Report Data z
SHMP 23805 Online In service CRMSRV H323 mppl
Speech Servers 23806 Online In service CRMSRV H323 mppl
s = AR 23807 Online In service CRMSRWY H323 mppl
MegEnOnTecTinG 23808 Online In service CRMSRY  H323 mppl

VPMS Servers
¥ Reports

Application Summary

Application Detail m

Call Summary

Call Detail

Performance

Session Summary

Session Detail

Figure 26: Port Distribution

3. Place a call to Avaya Voice Portal that invokes the Nuance OSA application. From the
Nuance OSA server, open the OSA Monitor from Admin Tools. Verify that it detects an
active call as shown in Figure 27.

; Call monitoring on pocroom - Microsoft Interne... =]

Calls monitor for

3 calls so far for pocroom,
1 call in progress for farm
[concurent peak 1, Tue Jun 17 18:12:22 ELT 2008)

192,455,122, 51
[

Figure 27: OSA Monitor

4. Verify that the Nuance OSA greeting is heard and OSA transfers the call to the proper
destination specified in a spoken name or extension entered via DTMF.
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5. From the OSA Monitor, click on the system name (e.g., pocroom) to display an internet
browser window that can display the call log. Under Call logs in the left pane, click on
Today under From archive. Verify that the call log shown in Figure 28 is displayed
with the correct call information and status.

#3 Openspeech Attendant - Microsoft Internet Explorer M=

File Edit Wew Favorites Tools Help | :l'
Qback - £ - [ [ @@ | ) search <7 Favorites  £2 | - B

Address I@ http:/flocalhost: 8080/ Openspeechfdttendantserviet faa?action=statuss:

e ‘Links B
OMSpeech
ATTENDANT =

Hosted on pocroom

Description: Auto Attendant Wersion: 3.0.0 (GA) Build: 2008.04,10,12,58,04

|Ej Done

N

n e
Sections Logs from archive (on disk), 16 sessions last 15 calls 'l Dkl =
Summary skakus call Terminati
Farm status Call start  Dnis clid 2 - ermination Destination System Comment Tagging

complexity code
Documentation 18:35:03 23603 77304 5 17 DVE Croft, Lara transfer
completed
Reports
15133132 235803 77303 3 2z DWE Croft, Lara transfer
3 054 Servist Eemelstsd
D Environmenkt 12:32:28 23802 F7F202 x) 22 [a]alc] Toplavel transfer
[ Carfiguration (HEmw completed
[ mstallation lag 16:14:58 23803 77303 o 11 His DMIS Test caller hangup
{:l Monitoring
12:12:21 23802 F7204 x) 14 HG Toplavel caller hangup b
Menu
= Replication Monitor 171383134 23302 TT303 z0 23 SRIZ Zrmith, John transfer
: Replication Status cernplatad
D Replication Errors 17:37:54 23802 77203 20 24 SRIZ Srnith, John transfer
completed
= Calllags 17:35:27 75200 F7F303 20 28 SRIZ Srnith, John transfer
B . completed
D Currently active
=S From archive 17:34:14 75200 77303 o 23 [alalch Toplevel transfer
PP : Menu completed
_ 5 =l
S I T 17,9917 75700 FFEN n EE) [aTartc) Trnlana teamcfar

’_’_l_’_ \v; Local intranet v
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Figure 28: Call Log
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7. Support

To obtain technical support for Nuance OpenSpeech Attendant, contact Nuance via email or
through their website.

= Web: www.network.nuance.com
= Email: SpeechAttendant.Support@nuance.com
= Phone: (866) 434-2564 or (514) 390-3922

8. Conclusion

These Application Notes describe the configuration steps required to integrate Nuance
OpenSpeech Attendant with Avaya Voice Portal. All feature and serviceability test cases were
completed successfully.

9. Additional References
This section references the product documentation that is relevant to these Application Notes.

[1] Administrator Guide for Avaya Communication Manager, Document 03-300509, Issue 3.1,
February 2007, available at http://support.avaya.com.

[2] Feature Description and Implementation for Avaya Communication Manager, Document
555-245-205, Issue 5, February 2007, available at http://support.avaya.com.
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